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Overview of product updates

IBM® Tivoli® Monitoring for Transaction Performance 5.2 Fix Pack 1 provides the following product

features and enhancements:

Table 1. Fix Pack 1 updates

Updated operating system and database support

Refer to

Windows® 2003 operating system support for
management agents

“Management agents on the Windows 2003 operating|

sXstem’ |

WebSphere Application Server, Version 5.0.2, support for
management agents

[“WebSphere Application Server 5.0.2” on page 2|

Enhancements to Tivoli Data Warehouse Enablement
Pack, Version 5.1.0.5

"“Enhancements to Tivoli Data Warehouse Enablement|
Pack 5.1.0.5” on page 2|

Simplified fix pack installation

ISMP-based installers and automatic upgrade
functionality

[“ISMP launcher and AutoUpdate” on page 3|

Installation procedure

|“Installation procedure” on page 3

Enhanced components and reports

AutoUpdate function for upgrading management agents

" AutoUpdate feature for uperading management agents”|
on page 6|

Generic Windows subtransaction thresholds for gathering
subtransaction performance data

|“Generic Windows subtransaction thresholds” on page 7|

Enhancements to real-time reports

[“Real-time report enhancements” on page 7

New command for updating information about your
J2EE installation in response to changes that have
occurred since the J2EE component was deployed

“Command for uninstalling the J2EE component” on|

page 2|

Problem determination information

[“Updated problem determination information” on page §

Updated operating system and database system support

This section describes updated operating system and database support for IBM Tivoli Monitoring for

Transaction Performance 5.2.

Management agents on the Windows 2003 operating system

The fix pack supports management agents on the Windows 2003 operating system. Perform the following
procedure to install a management agent on a computer running the Windows 2003 operating system:

1. Insert the CD labeled 5.2-WTP-FP01 on the computer on which you want to install the management

agent.



2. Run the following command:
change user /install

Additional information: The change user /install command changes the user mode to "install.” The
OSMAIN variable might resolve incorrectly if you do not run this command before performing Step
3. Run the setup_MA_w2003.exe command to install the management agent.
4. Perform the following steps to ensure that the management agent performs correctly on the Windows
2003 operating system:
a. Open Internet Explorer, and select Tools » Internet Options.
b. Click the Security tab in the Internet Options window.
c. Highlight the Internet icon (the globe), and click Custom Level.
d. Specify Medium in the Reset Custom Settings box, click Reset, and click OK.

WebSphere Application Server 5.0.2

The J2EE monitoring component supports installation on WebSphere Application Server 5.0.2. The
supported versions of WebSphere Application Server 5.0.2 include Base, Enterprise Edition, and Network
Deployment managed servers.

Enhancements to Tivoli Data Warehouse Enablement Pack 5.1.0.5

The fix pack provides several improvements to the Tivoli Data Warehouse Enablement Pack for IBM
Tivoli Monitoring for Transaction Performance 5.2. The patch that contains the modifications is located in
the following directory:

5.2-WTP-FPO1\tedw_apps_et1\fp01l

For more information, and for patch installation instructions, see the Tivoli Data Warehouse Enablement
Pack for IBM Tivoli Monitoring for Transaction Performance 5.2 Readme, which is located in the following
directory:

5.2-WTP-FPO1\tedw_apps_et1\fpOl\bwm\doc

Note: Before uninstalling and reinstalling Tivoli Data Warehouse Pack to the same source database, read
and understand the following critical information. If you installed Tivoli Data Warehouse
Enablement Pack, Version 5.2 in a Warehouse environment against an IBM Tivoli Monitoring for
Transaction Performance source database and ran ETL processes and generated reports, you must
perform the following steps before uninstalling the Tivoli Data Warehouse Enablement Pack with
the intention to reinstall it pointing to the same source database:

1. Locate the bwm_cdw_del_data.sql file in the following directory: <Tivoli Warehouse install
directory>/apps/bwm/pkg/v510/cdw/dml. This SQL file executes during the uninstallation.
2. Comment out the following lines by appending "--" at the beginning of each line:

--delete from twg.extract_control where extctl_target like 'BWM%';
--delete from twg.extract_Tog where extlog_target like 'BWM%';

3. Save the file.

4, Run the uninstallation for the Tivoli Data Warehouse Enablement Pack to maintain the extract
control values for the Tivoli Data Warehouse Enablement Pack.

After performing the above steps, you can now reinstall the Tivoli Data Warehouse Enablement
Pack against the same source database. The ETL process will reengage from where it stopped from
the extract control.



Installing IBM Tivoli Monitoring for Transaction Performance 5.2 Fix
Pack 1

This section describes the fix pack installation utilities and provides the recommended installation
procedure.

ISMP launcher and AutoUpdate

The fix pack provides the following utilities for installing the upgrade code on all supported platforms:
* ISMP launchers for installing the fix pack on the management server

* AutoUpdate, which enables you to automatically install upgrade code from the management server to

selected management agents

You are required to uninstall and reinstall existing J2EE monitoring components after upgrading the
management server and management agents. This ensures that the J2EE monitoring components use the
fix pack code.

Installation procedure
1. Perform the following steps to install the fix pack:
a. On the management server, insert the CD labeled 5.2-WTP-FP01.

b. Launch one of the following executable files to run the installation program for your operating
system:

Table 2. ISMP-based installers for management server upgrades

Management server installer file names Management server operating systems

setup_MSFixpack_w?32.exe Microsoft Windows 2000

setup_MSFixpack_sol.bin Solaris Operating Environment

setup_MSFixpack_lin390.bin zLinux

setup_MSFixpack_lin.bin Intel-based Linux platforms, including Red Hat Linux,
SuSE Linux, and TurboLinux

setup_MSFixpack_aix.bin AIX

2. Follow the instructions in the Install wizard to install the management server.

Note: WebSphere Application Server is stopped and restarted during the procedure. If your
management server is currently set up to use port 9449, change the management server port
number to use a different port number (such as the default port of 9445) when prompted for
port numbers in the management server. Port 9449 is used by an IBM Tivoli Monitoring for
Transaction Performance listening function.

3. Perform the following steps from an upgraded management server to upgrade the management
agents:

a. (If you are updating management agents on which the J2EE monitoring component is installed) Run the
updateprops command if any of the following circumstances exists:

* The J2EE monitoring component is running on an application server where security is enabled,
and the user ID or password has changed.

¢ The J2EE monitoring component is running on an application server where security was not
enabled when the component was installed, and security is now enabled.

¢ The J2EE monitoring component is running on an application server using an administrative
port number that has changed.



Additional information: The updateprops command enables you to change the user ID, password, or
administrative port number that the fix pack uses to connect to the application server. For more
information about the upgradeprops command, see|“Command for uninstalling the J2EE|
[component” on page 7]

Start IBM Tivoli Monitoring for Transaction Performance using the following steps:
1) Launch Microsoft Internet Explorer.
2) Access the management server by typing in the management server URI.

Additional Information: The following examples show URIs for a nonsecure and a secure
installation of a management server called myhost.ibm.com, using the default port numbers:

* For HTTP (nonsecure):
http://myhost.ibm.com:9081/tmtpUI

* For HTTPS (secure):
https://myhost.ibm.com:9445/tmtpUI

Select System Administration » Work with Agent Updates to display the Work with Agent
Updates window.

d. Select all of the management agents on which you want to install the fix pack.

e. Select Install Update from the drop-down list, and click Go.

Additional information: The selected management agents download the required software and
update with the required files. For more information about the AutoUpdate function, see the
online help information. To access online help, click the question mark (?) in the upper-right
corner of the window. See also [“AutoUpdate feature for upgrading management agents” on page]

4. (If you have active J2EE monitoring components in your environment) Perform the following steps to
ensure the correct operation of the J2EE monitoring component:

a.

Navigate to System Administration » Work with Agents, and select the agents on which the J2EE
component is running.

Select Remove component from the drop-down list, click Go, and specify the J2EE component for
removal.

Stop the J2EE-instrumented application servers.

. Stop the management agent process.

e. Open the <MA_root>/app/instrument directory, and delete all the files and directories in the

f.

directory.

Delete the files and shared libraries that were installed on your application server when the J2EE
component was installed.

Additional information: Following is a list of the files and libraries installed with the J2EE
component, listed by application server platform and operating system:

WebSphere Application Services Versions 4 and 5:

<APP_SERVER_HOME>/lib/ext/armijni.jar
<APP_SERVER_HOME>/lib/ext/copyright.jar
<APP_SERVER_HOME>/lib/ext/ core_util jar
<APP_SERVER_HOME>/lib/ext/ejfltjar
<APP_SERVER_HOME?>/lib/ext/eppam.jar
<APP_SERVER_HOME>/lib/ext/jtfdcjar
<APP_SERVER_HOME> /lib/ext/jflt jar
<APP_SERVER_HOME>/lib/ext/jlog.jar
<APP_SERVER_HOME?>/lib/ext/probes.jar

WebLogic:

<APP_SERVER_HOME>/server/lib/ext/armjni.jar
<APP_SERVER_HOME?>/server/lib/ext/copyright.jar



<APP_SERVER_HOME> /server/lib/ext/core_util jar
<APP_SERVER_HOME> /server/lib/ext/ejflt jar
<APP_SERVER_HOME>/server/lib/ext/eppam.jar
<APP_SERVER_HOME> /server/lib/ext/jffdc.jar
<APP_SERVER_HOME>/server/lib/ext/jflt jar
<APP_SERVER_HOME?> /server/lib/ext/jlog.jar
<APP_SERVER_HOME>/server/lib/ext/probes.jar

WebSphere windows platforms:

<APP_SERVER_HOME> /bin/ijitipi.dll
<APP_SERVER_HOME> /bin/jitipi.dll

WebSphere UNIX platforms:

<APP_SERVER_HOME?> /bin/libjitipi.so
<APP_SERVER_HOME> /bin/libijitipi.so

WebLogic windows platforms:

<APP_SERVER_HOME> /server/bin/ijitipi.dll
<APP_SERVER_HOME> /server/bin/jitipi.dll

WebLogic AIX platforms:

<APP_SERVER_HOME> /server/lib/aix/libjitipi.dll
WebLogic xLinux platforms:

<APP_SERVER_HOME>/server/lib/linux/i686/libjitipi.dll
<APP_SERVER_HOME> /server/lib/linux/i686/libarm.so
<APP_SERVER_HOME?> /server/lib/linux/i686 /libarmjni.so

WebLogic Solaris platforms:

<APP_SERVER_HOME?> /server/lib/solaris/libjitipi.dll
g. Start the management agent process and application servers.

h. Navigate to System Administration + Work with Agents, and select the agents on which the J2EE
component was running before you uninstalled the component.

i. Select Deploy J2EE Monitoring Component from the drop-down list to redeploy the J2EE
component on the specified agents.

5. (For new management agent installations only, excluding Windows 2003 and z/OS): Perform the following
steps to install a new management agent (not upgrade):

a. Perform a management agent installation using the IBM Tivoli Monitoring for Transaction
Performance, Version 5.2 installation images as described in the IBM Tivoli Monitoring for
Transaction Performance Installation and Setup Guide.

b. Update the Version 5.2 agent.jks key file by performing the following steps:
1) Access the installation files for Fix pack 1.
2) Replace the Version 5.2 agent. jks key file with the Fix pack agent.jks key file.

Enhanced components and reports

This section describes the following additions and modifications to components and real-time reports:

AutoUpdate functionality
Enables you to automatically install product upgrades, including this fix pack, on multiple
management agents in your environment. AutoUpdate frees you from having to manually
upgrade each individual management agent.



Generic Windows subtransaction threshold
Enables you to set thresholds for Generic Windows subtransactions, in addition to setting
thresholds for the overall transaction.

updateprops command for uninstalling J2EE components
Provides command-line support for preparing to install a J2EE monitoring component in response
to changes in user name, password, or port for the application server.

Subtransaction Performance report
Enables you to investigate the performance of a subtransaction over a specified period of time.
You can also specify the Subtransaction Performance view when investigating nodes in the
topology report. The report is accessible only from a topology node.

Overall Transaction Over Time report
Expands the number of management agents for which you can view data from five to 100, and
enables you to select agent groups and individual management agents for display.

AutoUpdate feature for upgrading management agents
The AutoUpdate feature enables you to perform the following tasks:

* Automatically install fix packs and any future product updates on multiple management agents and
monitoring components

* Uninstall updates
* Enable and disable automatic update functionality

When an installed update affects both the agent and one or more monitoring components, the agent is
updated first, followed by the components. Uninstallations proceed in reverse order, with update code
uninstalled from the components first, and then from the agent. The specified update starts at the next
polling interval. The polling interval is the regularly scheduled time (by default, every 15 minutes) when
new information is sent to the management agents.

A table in the Work with Agent Updates window informs you whether an update is available for a
particular agent and provides update status. The table also shows the monitoring components that are
running on each agent and displays the update status of each component.

Using AutoUpdate
To begin using AutoUpdate, select System Administration + Work with Agent Updates in the main
menu. The online helps provide detailed step-by-step information about using the feature.

Events related to AutoUpdate
The fix pack includes two events that inform you whether AutoUpdate uninstallations have succeeded or
failed.

The following event indicates a successful uninstallation:

<message
id="0x002C"
tms_id="ITPMS0094I"
tms_prefix="no"
event_family="ManagementServer"
symbol="ROLLBACK_COMPLETE"
alt_symbol="Rollback-Complete">
<text>An endpoint rollback process has completed successfully. {0}</text>

The following event indicates a failed uninstallation:

<message
id="0x002D"
tms_id="ITPMSO095I"
tms_prefix="no"
event_family="ManagementServer"



symbol="ROLLBACK_FAILED"
alt_symbol="Rollback-Failed">
<text>An endpoint rollback process has failed due to an error. {0}</text>

Generic Windows subtransaction thresholds

IBM Tivoli Monitoring for Transaction Performance 5.2 enables you to set thresholds on an overall
Generic Windows transaction, but not on subtransactions. The fix pack introduces the ability to set
thresholds on Generic Windows subtransactions.

During the process of creating a new Generic Windows policy, you can create thresholds only on the
overall transaction. To create a subtransaction threshold, you first run the policy and then consult the
topology view, where subtransactions are displayed as nodes. From the topology, you can right-click a
subtransaction node and specify Thresholds View to create a threshold.

The online helps provide more information about the use of Generic Windows subtransaction thresholds.

Real-time report enhancements

The fix pack offers the following updated functionality for reports. See the online helps for more
thorough discussions.

Subtransaction Performance
The fix pack introduces the Subtransaction Performance line graph, which enables you to
investigate the performance of a subtransaction over a specified period of time. Lines in the
graph depict times detected by up to 100 individual management agents. You can display up to
five of the lines in color and with points that represent aggregate data collected during the
reporting period.

When you right-click on a base node in the topology report, the menu includes the
Subtransaction Performance View item, which you can select to inspect subtransaction
performance.

Overall Transaction Over Time
The fix pack provides a number of modifications to the Overall Transaction Over Time report.
You can select an agent group to graph data collected by all members of that group, in addition
to selecting individual agents. The modified report also expands the number of management
agents you can display from five to 100, with lines in the graph depicting times that were
collected during the reporting period. You can display up to five lines in color and with points
that represent aggregate data. The lines that are not displayed in color are in the grayed-out
background of the graph and can be moved to the foreground (shown in color) at any time.

Command for uninstalling the J2EE component

The fix pack provides the updateprops command that you use in preparation for uninstalling the J2EE
monitoring component. You might want to uninstall a J2EE component when changes exist that affect
access to the J2EE-instrumented application server. A J2EE component installation depends on a user
name, password, or port for the instrumented application server, and some or all of that information
might have changed since the installation was completed.

updateprops command usage

If your authentication information has changed on the J2EE application server since the J2EE component
was installed, you run the updateprops command before removing the J2EE component. The command
takes two parameters, serverName and serverHome, as illustrated in the following example:

updateprops.sh -serverName serverl -serverHome /opt/WebSphere/AppServer



The command prompts you for a user name, password, and port number. If you do not want to change
any of these fields, press the Enter key. The appropriate properties file is updated with the new value.
Passwords are encrypted and written to the properties file, and you can now remove the J2EE
component.

Updated problem determination information

The following information helps you diagnose and resolve problems.

After installation, the Store and Forward agent fails to register with the management server on AIX,
Version 5.1 with maintenance level 5100-02.
After installing the Store and Forward agent on an AIX, Version 5.1 operating system with
maintenance level 5100-02, the Store and Forward agent will be unable to register with the
management server because the ibmproxy service dies shortly after starting. To resolve this
behavior, install an AIX operating system with maintenance level 5100-03.

Port 50000 is required for a management server with an embedded DB2 installation. However, port
50000 is also used by the SuSE SLES 8.0 operating system.

Note: This item and the associated workaround apply only to installations of IBM Tivoli
Monitoring for Transaction Performance 5.2. The fix pack does not provide a new
management server installation.

A port conflict can occur if a management server with an embedded DB2 installation is

performed on a computer that has a fresh installation of the SuSE SLES 8.0 operating system. The

SuSE SLES 8.0 operating system claims port 50000 in /etc/services, but that port is also used by

the DB2 instance. As a result, the DB2 installation stops. If this occurs, the following error is

displayed in the /tmp/db2setup.his file:

ERROR:DBI1702E The specified service name or port number conflicts with
existing values in the TCP/IP services file.

To resolve this error, edit the /etc/services file by commenting out the following lines before
performing a management server installation with an embedded DB2 installation:

mrt 50000/ tcp # telnet interface of mrt programs
mrt 50000/udp # telnet interface of mrt programs

The topology report cannot be viewed and navigated in the IBM Home Page reader
The topology is an applet, and applets are not supported by Home Page Reader. However, all of
the topology data is also available in a tabular format. The ability to view the data in tables
makes the topology accessible by sight-impaired users, in accordance with guidelines set forth by
IBM accessibility checklists. Tables can be viewed in the IBM Home Page reader.

Installation of IBM Tivoli Monitoring for Transaction Performance 5.2 fails on a management server
running the Intel-based SLES 8.0 operating system.

Note: This item and the associated workarounds apply only to the installation of IBM Tivoli
Monitoring for Transaction Performance 5.2. The fix pack does not include a new
management server installation.

When you install the IBM Tivoli Monitoring for Transaction Performance 5.2 management system,

the installation utilities look for a file named

<WAS_BASEDIR> /properties/version/was50_fp1_linux390.ptf. On Intel-based installations, this

file does not exist.

Use either of the following two workarounds to install a management server on the Intel-based
SLES 8.0 operating system:

* Depot installation (see the IBM Tivoli Monitoring for Transaction Performance 5.2 Installation
Guide for more information). Before starting the installation process, edit the MsPrereq.xml file
and remove 390 from the line containing the file name
<WAS_BASEDIR> /properties /version/was50_fp1_linux390.ptf. Continue with the installation.



* Zero-size file named <WAS_BASEDIR>/properties/version/was50_fp1_linux390.ptf. When you
create a size 0 file having this name, the installation process sees that the file exists and
proceeds correctly. This workaround is useful when you must install from a CD.

The management server GUI sometimes fails to load after you install the Windows Internet Explorer
KB832864 security patch.
If you have installed the KB832864 security patch for Internet Explorer on a Windows operating
system and can no longer launch the management server GUI, perform the following steps:

Launch Internet Explorer.

Click Tools » Internet Options, and click the Advanced tab.
Clear the Use HTTP 1.1 check box under HTTP 1.1 settings.
Click OK, and close the browser.

5. Open a new Internet Explorer browser, and log in to the management server.

oD~

Clearing the Use HTTP 1.1 check box sometimes breaks other Web applications you are using. If
this occurs, perform the following steps to enable all browsers that have the patch to log in to the
management server, regardless of the Use HTTP 1.1 setting:

1. Browse to the URL http://<MS_HOSTNAME>:9090/admin to open the WebSphere
Administrator Console for the management server.

2. In the navigation tree, select Servers » Application Servers to open the Application Servers
window.

Select serverl to open the Web Container window.

Click HTTP Transports to open the HTTP Transports window.

Click the underlined asterisk (*) in the 9445 row to open the 9445 window.

Scroll down the page, and click Custom Properties to open the Custom Properties window.
Click New to open a New window.
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Type MaxKeepAliveConnections in the Name field.
9. Type 0 in the Value field, and click OK.
10. Click Save in the Message box.
11. Click Save in the Save to Master Configuration box to save the new setting.
12. Restart the management server.

The Windows 2003 Internet Explorer browser does not load the management server GUI if the site is
not trusted.
If you are unable to launch the management server GUI on a Windows 2003 operating system,
perform the following steps: Click File » Add this site to » Trusted Sites Zone. The login
window is displayed.

Applications added to an existing XML file are not displayed in the Component Management
window.
If you enable an ARM application that has an XML file, and add new applications to that XML
file, the applications are displayed in listening policy-related windows, but not in the Component
Management window.

To enable new applications to be displayed in the Component Management window, create an
additional XML file for your new application instead of editing the existing XML file.

Uninstalling the fix pack from the Control Panel fails to completely remove the directory structure.
To completely remove the directory structure, uninstall the fix pack only from the Work with
Agent Updates window. You must uninstall the fix pack before uninstalling IBM Tivoli
Monitoring for Transaction Performance 5.2.

Registration with a management server is restricted to 500 management agents.
This fix pack enforces a maximum limit of 500 management agents that can register with a
management server. If a management agent installation is attempted after the 500 management



agent limit is reached, the management agent is unable to register with the management server.
The management agent installation log contains the following message: <! [CDATA[500 agents
installed. Max Tlicenses exceeded.]]>

The J2EE monitoring component deployment code sometimes fails to instrument the start script.
When the J2EE monitoring component is deployed to a WebLogic application server that is
started by a script, the instrumentation code is automatically inserted in the start script
immediately before the Java command. The Java command invokes the Java virtual machine
JVM).

In most WebLogic 7 start scripts, instrumentation code is added with a call to the startWLS script
in the WL_HOME/bin directory. When the start script invokes the startWLS script, the J2EE
monitoring component inserts instrumentation code just before the call to startWLS. If the
application server start script does not invoke startWLS, but invokes the JVM directly, the J2EE
monitoring component code fails to instrument the start script

To prevent this problem, insert one of the following comments into the application start script,
just before the call to start the application server JVM:

* (For a Windows CMD program) "@rem Insert TMTP Instrumentation"
— OR —
* (For a Unix shell script) "# Insert TMTP Instrumentation"

In certain circumstances, Generic Windows is unable to play back a 3270 emulation recording.
Generic Windows is sometimes unable to play back a 3270 emulation recording. This occurs most
frequently when the recording is in Japanese. Most users are able to successfully play back
emulation recordings. There is, however, no formal support for terminal emulation playbacks.

The database transaction log fills up when enabled applications have large numbers of transactions.
If your environment has many enabled applications (such as 20 applications) with XML files
containing large numbers of transactions (such as 8000 transactions), the database transaction log
might become full. If this occurs, an error message displays stating that an application with that
name already exists on that management agent. The trace log displays an error that the
transaction log is full in the database. To resolve this error, increase the database transaction log
file size and restart. For instructions on how to increase the transaction log file size for your
database, consult the database documentation.
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